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[A].- Goals 

REVIT Truss Designer is a REVIT add-in that allows for the automatic generation of truss 

structures and their subsequent incorporation into a project.  

The trusses are not defined by the coordinates of their joints and the connectivity of the 

members, but rather by global geometric parameters. The characteristics of the sections and 

materials are also parameterized.  

When the user changes the value of any parameter, the truss is updated and the system 

dynamically presents the results. When the desired design is reached, it is inserted into a REVIT 

project with also configurable conditions. 

[B].- Access and organization of the main panel 

REVIT Truss Designer is accessed from the “Add-ins” tab. Clicking on “Truss Designer” you get 

its main panel. 

 

 

This window includes various areas, some of the areas can be hidden or vary in layout or 

content. The layout of the image corresponds to the initial example of the program. The 

following sections ([C] to [M]) describe the 11 possible zones.  

 



REVIT TRUSS DESIGNER                                                                                                                                                           USER GUIDE 

 
 

PAGE 4 
 

  

[C].- Title bar 

 

The upper title bar includes in the left area the icon and name of the add-in (“Truss Designer”), 

its version (“v1.00”) and the name of the open file (“Example_01”). 

In its right area it incorporates the controls to minimize the window, move it to the upper left 

corner of the screen (or restore it) and close the application. 

With the usual operation of Windows applications, the program icon (or pressing the right 

mouse button on the title bar) gives access to the keyboard control menu, dragging the title 

bar allows changing the position of the window and double-clicking the left mouse button 

toggles the positions on the screen. 

[D].- Main menu 

 

Although most of the operations can be carried out through direct icons on the screen, the 

add-in's main menu collects the commands that give access to all of them and functionally 

organizes them into 8 submenus: 

The File submenu includes the functions for creating the different types of structures and 

opening and closing them, as well as saving them in the corresponding files. 

The Edit submenu contains access to the control blocks for the definition of parameters, 

members, materials and sections. 

The View submenu contains the different configuration and display options for the work 

screen. 

The Process submenu includes those corresponding to the insertion of the truss in the REVIT 

project and its export to a DXF file. 

In the Options submenu, the possibilities of establishing the background color in the graphic 

area and data, parameter and editing grids are provided, as well as the activation/deactivation 

of warning messages (confirmation requests and notifications) and the automatic detection of 

joints and members in the vicinity of the cursor. 

The Config submenu allows the storage and loading of customized configuration files. 

With the Language submenu, all the add-in texts are exchanged between Spanish and English 

at any time. 

Finally, the Help submenu includes the control to activate or deactivate the presentation of 

pop-up messages, the download of the user manuals (in Spanish and English) and the features 

video, as well as the access to the “About Truss Designer” panel. 
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[E].- Toolbar 

 

Below the main menu is the toolbar, which gives direct access to the most common functions. 

When you hover over an icon a pop-up text indicates its meaning. They are all listed below: 

SYMBOL DESCRIPTION 

 
  
 New beam type parametric structure 

 New column type parametric structure 

 New lattice type parametric structure 

  
 Parameter edition 

 Members edition 

 Materials edition 

 Sections edition 

 Display mode 

  
 RE&VIT elements generation 

 DXF graphic file generation 

On the right side of the same line, the system shows the coordinates of the cursor at each 

moment. 

[F].- Graph area 
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Arranged in the central area of the screen, the graphic area contains the representation of the 

structure with the geometric distribution of its joints and members. For a better visualization, 

the system performs an automatic scaling based on the dimensions of the model. 

The thicknesses and colors of the members can be fixed or variable depending on the area of 

the section, the type of section and the corresponding material. 

The equivalence between the thicknesses or colors and the corresponding ranges of values is 

represented in the legends located to the right of the graph. These legends automatically 

adapt (in position and scales) to the variables they represent and to the maximum ranges of 

their corresponding values. 

In addition, each member can be associated with a text with different possibilities of 

information (area, section type or material). 

Each time the cursor passes over a member, the system automatically identifies it with a thick 

line and yellow color and shows, also in yellow, the corresponding ranges in the legend and the 

associated line in the member data grid. Similarly, if the cursor is placed on a joint, the 

program represents it with a circle with a larger radius and yellow color, like its corresponding 

line in the joint data grid. 

[G].- Data grids 

The data values corresponding to the joints, members, materials and 

sections are represented to the right of the graphic area in four grids 

with lateral scroll bars (vertical scroll). 

These grids indicate the coordinates of the joints, the initial and final 

joints of each member, its length, material and assigned section, the 

length and weight of all the members of each material, of each 

section and totals. 

When the cursor is passed over the header lines of the grids, the 

system presents a pop-up help text with the meaning of each column. 

The width of each column is modifiable by the user dragging with the 

mouse (to the right or left) the separation line with the adjacent 

column in the title bar. 

In any case, if a quantity is not fully displayed, when you move the 

mouse over it for a few moments, the system presents a pop-up 

message with the full value. 

The data grids are automatically updated when any data or parameter 

changes, even if it is not included in them. 
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These grids are computerized linked to the graphic area. When the different elements are 

selected in the graphic (joints, members, materials or sections), the system automatically 

marks the corresponding rows with a yellow background in the grids. 

On the other hand, to identify a joint or member in the graph, or all the members with a 

certain material or profile, it is enough to select the corresponding rows in the grid with the 

mouse. 

In addition, once a row is selected, with the grid active, the cursor movement keys allow you 

to go through the structure (the right and lower arrows forwards and the left and upper 

arrows backwards). The [Page Down] and [Page Up] keys are also available to jump forward in 

each frame. 

[H].- Parameter edit controls 

Below the graphic area and the data grids are the panels that contain the various parameter 

editing controls. For each type of truss (“Beam”, “Column” or “Lattice”) there is a parameter 

grid and all of them are listed below. 

EDITING PARAMETERS OF BEAM-TYPE STRUCTURES 

 

DESIGN OPTIONS 

  

 

 

BEAM options 

  Mirror 

  
NUMERIC PARAMETERS 

   
 

Number of panels [] 

 
Total length [cm] 

 
Height increment between ends [cm] 

 
Truss rotation [10-2 º] 

 
Depth [cm] 

 
Depth increment on left end [cm] 

 
Depth increment on right end [cm] 

 
Parabolic depth variation [cm] 

 
Parabolic height variation [cm] 

 
Intermediate depth increment [cm] 

 
Intermediate height increment [cm] 

 
Intermediate position [cm] 
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EDITING PARAMETERS OF COLUMN-TYPE STRUCTURES 

 

DESIGN OPTIONS 

  

 

 

COLUMN options 

  
Mirror 

  
NUMERIC PARAMETERS 

   
 

Number of panels [] 

 
Total height [cm] 

 
Width increment between ends [cm] 

 
Truss rotation [10-2 º] 

 
Base width [cm] 

 
Top width [cm] 

 
Left side parabolic variation [cm] 

 
Right side parabolic variation [cm] 

 

 

EDITING PARAMETERS OF LATTICE-TYPE STRUCTURES 

 

DESIGN OPTIONS 

  

 

 

LATTICE options 

  
Mirror 

  
NUMERIC PARAMETERS (1 TO 6) 

   
 

Number of horizontal panels [] 

 
Total length [cm] 

 
Number of vertical panels [] 

 
Total height [cm] 

 
Height increment between ends [cm] 

 
Width increment between ends [cm] 
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NUMERIC PARAMETERS (7 to 12) 

   
 

Horizontal linear variation [cm] 

 
Vertical linear variation [cm] 

 
Upper side parabolic variation [cm] 

 
Bottom side parabólic variation [cm] 

 
Left side parabólic variation [cm] 

 
Right side parabolic variation [cm] 

All the numerical parameters have editing controls that consist of three computerized linked 

components: the identification icon on the left, the central slider bar and the editing box on 

the right. 

 

The user can interact with each of them in nine different ways: 

 To provoke the gradual variation of the variable, you can select with the mouse the 
blue marker of the sliding bar and drag it horizontally to the left or right with the 
left button pressed. When this is done, the new number of spans is automatically 
reflected in the edit box, and the structure dynamically adapts its geometry. 

 You can also click the mouse on the slider area on either side of the marker. By 
holding down the left button, the marker slides to the cursor position and the 
system updates the variable and represents the new truss. 

 When selecting the scroll bar, the system frames it with dotted lines and the 
horizontal and vertical forward and backward keys (arrows) are activated. Each 
time the right (or down) arrow is pressed, the marker advances one position, the 
variable is increased by one unit, and the structure adapts. With the left arrow (or 
the upper one) the values are gradually reduced. It is a very comfortable procedure 
to analyze the influence of changes in the variable. If the arrows are held down for 
a while, the changes increase their speed. 

 With the scroll bar also selected, the Page Up and Page Back keys ([Page Down] and 
[Page Up]) produce a similar effect to the arrows but with a much greater rate of 
change per press. With these keys you can analyze the relevant changes of the 
variables, leaving the arrow keys for a more precise adjustment. 

 In any case, a specific value can be directly assigned to the variable by clicking the 
mouse on the editing box (it is marked with a blue background) and entering the 
desired numerical quantity with the keyboard. When finished with the [Enter] key, 
the system updates the position of the marker on the slider bar and represents the 
new structure. 

 The selection of the editing box also enables the use of the upper and lower arrows 
(using the keyboard or clicking on the icons on the right) for the gradual variation 
of the parameter. 
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 All numeric controls are assigned a default value. This can be automatically reset by 
clicking the right mouse button on the variable icon. 

 For a better identification of each control, a system of pop-up information 
messages has been provided that are activated by placing the mouse over the icon, 
without pressing any button (indicating its meaning), on the sliding bar (indicating 
its description). or on the editing field (indicating, where appropriate, the units 
used). 

 Finally, when clicking on the icon of a numerical parameter, the add-in presents a 
panel with all its features and configuration possibilities: 

 

The upper zone contains the identification data (icon and number) and the name and 

description of the parameter. 

The center left area shows an example with two different parameter values. This allows us to 

graphically appreciate the effects of its variation. 

In the right area, the units are indicated and the operating values of the parameter are 

displayed and/or configured: variation range, characteristics of the slider, operation of the 

numerical field, default value and observations. 

The lower left zone includes the buttons for modifying these operating characteristics and 

exiting the panel. 

If, while keeping the panel visible, you click on the icon of another parameter, the system 

updates the panel with the information of the latter. This allows sequential scrolling of all 

parameters. 

 

 



REVIT TRUSS DESIGNER                                                                                                                                                           USER GUIDE 

 
 

PAGE 11 
 

  

[I].- Member edit controls 

The Members Edit mode is accessed by activating the “Members” option from the “Edit” 

submenu or the icon  located in the fifth place of the tool bar. When this happens, the 

system presents the following panel of editing controls. 

 

The panel contains, from left to right, the options provided for the assignment of materials and 

sections to the previously selected members. 

The add-in contemplates multiple possibilities of member selection. The most immediate is the 

individual selection on the graph. With the arrow-shaped cursor, when the user clicks the left 

mouse button on the chart, the system searches for the member with the center closest to the 

cursor position, adds it to the selection, reflects a rectangle in its central area yellow and also 

mark its line in the corresponding data grid. 

This procedure is iterative. To add more members to the selection, click on them with the left 

mouse button. To remove any member from the selection, you can click on it with the right 

mouse button. 

If you right-click on an unselected member (or on a point on the chart away from the 

members) the system removes the entire selection. 

Selection based on data grids supports different possibilities depending on the data grid used. 

By left-clicking on a line in the member data grid, the corresponding member is selected and 

automatically represented by a yellow rectangle on the graph. 

In this first case, the system also removes the selection (if it exists) from the rest of the 

members. If you want to keep this previous selection and simply add new members from the 

grid, you must hold down the [Ctrl] key when clicking the lines. 

Also here, when pressing the [Shift] key and pressing a line, the system automatically selects 

all the existing ones, the previously selected one and the current one. 

If, keeping the left button pressed, the mouse is dragged through the members grid, all of 

them are selected (with [Ctrl] they are added to the previous selection). 

When the left button is clicked on a line of any of the two material or section grids, the 

program automatically adds to the selection all the members that have the material or section 

of the indicated line. 

In this case, each click on a new line adds the corresponding set of members without deleting 

the previous selection. Therefore, it is possible to act globally on the complete set of members 

of various groups of materials and/or sections. 

All selection methods can also be combined with each other and in any order to create the 

desired set of members. There is no problem in selecting a member several times. 
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Deselection from the member data grid is achieved by clicking the left mouse button again on 

the selected lines (in yellow). In this case, the [Ctrl.] and [Shift] keys are also operative. 

Once the members have been selected, materials and/or sections can be assigned to all of 

them. 

Model members always have a material assigned to them. When they are registered, the 

default program associates all the M01 material. It is the user who must, where appropriate, 

select them and change the material if necessary. 

To do this, the left control of the Members Edit panel is used. When activated, the system 

displays the list of materials defined so far and allows assigning any of them to all the 

members of the selected set. 

 

 

 

The cursor movement keys (arrows) and Pages ([Page Down] and [Page Up]) are operative in 

the drop-down list. If they are used, the assignment occurs with the [Enter] key. You can also 

click directly with the left mouse button on the chosen line. 

The assignment made can be easily verified by deselecting the previous selection and clicking 

on the corresponding line in the material data grid. 

Similarly, all members in the model always have a section assigned to them. When they are 

registered, the program associates all S01s and it is the user who must select them and assign 

them to the corresponding section. 

The control provided for this occupies the second position of the Member Edit panel. When 

activated, the system displays the list of sections defined so far and allows assigning one of 

them to all the members of the selected set. 

 

 

You can use the cursor movement and Pages keys and make the assignment with the [Enter] 

key, or click directly on the chosen line with the left mouse button. 
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To verify the assignments made, cancel the existing selection of members and then click on the 

chosen line in the section data grid. 

If an assignment is attempted without any member selected, the program cancels the action 

and presents the corresponding message on the screen. 

[J].- Material edit controls 

All the structural models include their own catalog of materials, to which the different 

members are associated. 

When a new structure is defined, the program incorporates, as a starting point, four materials 

in its catalog (steel, aluminum, concrete and wood) and identifies them with the codes M01 to 

M04. The user can modify their properties, define new materials or remove them from the 

model. 

The Materials Edit mode is accessed by activating the “Materials” option from the “Edit” 

submenu or the icon  located in the sixth position of the tools line. When this happens, the 

system presents the following editing control panel. 

 

The panel is automatically updated with the data of the selected material at all times and 

incorporates the corresponding options for registration, modification and cancellation. 

The control on the far left of the editing panel allows the user to add new materials, up to a 

limit of 10 per structural model. 

When the left mouse button is clicked and the confirmation is accepted, the add-in inserts a 

new material in the model, places it at the end of its specific catalog and automatically assigns 

the code immediately above the last existing one. 

In order for the new material to also have some initial reference data, all the characteristics of 

the steel are copied by default into its property fields. 

The selection of materials can be done in two ways: through the graph or through the data 

grid. 

When the left mouse button is clicked in the vicinity of a member on the chart, the program 

automatically selects the material corresponding to that member, represents all other 

members of the same material as selected, and marks the corresponding line in yellow in the 

grid of data (with the precise displacement to present it on the screen). 

You can also make the selection directly in that data grid. By clicking on one of its lines with 

the mouse, the system selects it and marks all the members of the corresponding material on 

the graph. 
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With the material data grid active, it is also possible to use the cursor movement keys (the 

arrows and Page forward and backward). By repeatedly pressing them, the program changes 

the selected material and indicates the associated members in the structure. 

In this case, the use of the [Ctrl] and [Shift] keys for multiple selection of lines does not make 

sense. Material selection is not cumulative. To avoid confusion with the properties reflected in 

the edit controls, multiple materials should not be selected at the same time. 

Each time a material is selected, the system accesses its property values and displays them in 

the corresponding data fields of the Material Edit panel. Modifying this data, followed by 

pressing the [Enter] key, directly updates the properties of the selected material. 

The first field in the panel is the name of the material. It is a short and purely descriptive name 

on screen and listings. 

The other property is the specific gravity. The following control is used to define its value in 

Kg/m3.  

 

It can be entered directly in the editing field and also modified dynamically via the slider bar or 

cursor movement keys. Pressing the right mouse button on the icon restores the default values 

(those corresponding to steel). 

Finally, the control located at the far right of the editing panel provides the user with the 

possibility of deleting materials in the active model. 

To do this, first select the material to be deleted, and by clicking on the icon the system 

displays the message with the mandatory request for confirmation. After acceptance, the 

material is removed from the catalog and from the corresponding data grid. 

The system always maintains the sequential and correlative order in the materials catalog and, 

if necessary, after each elimination, automatically changes the numbering of the rest of the 

materials until the end of the catalog. 

For example, if at a given moment there are 4 materials (M01, M02, M03 and M04) and the 

user deletes the M02 material, the add-in now designates the old M03 material with the M02 

code and the old M04 with the M03 code. 

 

 

Logically, with the numbering changes made by the system, the real associations of materials 

to the members are not altered. The program automatically assigns the material M02 to all the 

bars that previously had the material M03 assigned and the M04 to the members that had the 
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M04. The consistency in the changes is controlled by the system and is thus immediately 

reflected in the members data grid on the screen. 

With this procedure, there are never gaps in the numbering and any registration occurs at the 

end of the catalogue. 

Other controls carried out by the add-in are the existence of bars associated with a material to 

be eliminated and the guarantee of existence of at least one material in the catalog. 

[K].- Section edit controls 

In a similar way to the catalog of materials, the program contemplates in each model its own 

catalog of sections, to which the different members are associated. 

When a new structure is defined, the program initially incorporates 4 sections in its catalog 

(variables depending on the type) and identifies them with the codes S01 to S04. The user can 

modify its properties, define new sections or remove them from the model. 

The Section Edit mode is accessed by activating the “Sections” option from the “Edit” submenu 

or the icon  located in the seventh position of the tool line. When this happens, the system 

presents the following editing control panel. 

 

This panel is dynamically updated with the data of the section selected at all times and 

incorporates the corresponding options for registration, modification and cancellation. 

The first control of the editing panel allows the user to add new sections. The system supports 

up to 20 sections per structural model. 

When the left mouse button is clicked and the confirmation is accepted, the add-in inserts a 

new material into the model, places it at the end of its specific catalogue, automatically assigns 

the code immediately above the last existing one and adopts its characteristics. the values of 

the HEB 120 profile (default). 

The selection of sections can be done in two ways: through the graph or through the data grid. 

When the left mouse button is clicked in the vicinity of a member on the graph, the program 

automatically selects the section corresponding to that member, represents all other members 

in the same section as selected, and marks the corresponding line in yellow on the data grid. 

You can also define the selection directly in that grid. By clicking on one of its lines with the 

mouse, the system selects it and marks all the members in the corresponding section on the 

graph. 
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With the section data grid active, it is also possible to use the cursor movement keys (arrows 

and Page forward and backward). By repeatedly pressing them, the program changes the 

selected section and indicates the members associated with it in the structure. 

As in the case of materials, there is no point in selecting several sections simultaneously, since 

it would cause confusion in the association of values in the edit controls. 

When a section is selected, the program automatically displays the values of its properties in 

the corresponding data fields of the editing panel. If these data are changed, the system 

directly updates the characteristics of the selected section. 

The first block of panel options is made up of two icons that characterize the type of section. 

The first icon clicked indicates that the section is generic. The user defines all its 

characteristics. In the second case, the user selects the section within a catalog of profiles 

grouped into series. The program then adopts the values corresponding to the chosen profile. 

The following two controls are used to define the catalog profile associated with the section 

(unless it is generic, in which case they are disabled by the system). 

By clicking on the first one with the left button of the mouse, the system displays the list of 

series and by clicking on any of its lines, the program activates the second control and displays 

the list of catalog profiles for this series. 

When a line in this second list is clicked, the program assigns the chosen profile to the section 

and updates the rest of the editing fields with the values corresponding to this profile. 

 

Both drop-down lists are shown in the figure. In the first, the IPN series is selected and 

therefore the second offers all the profiles of this series. In the latter, the IPN 200 profile is 

marked and it is this that is assigned to the lower editing field. 
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For the choice of profiles in this catalog you can also use the cursor movement keys. 

The following edit control is only used for the definition of characteristics of generic sections. 

The system automatically prevents its modification when the section corresponds to a catalog 

profile. 

 

This control assigns the area in the sections defined by the user. The area is expressed in cm2 

with an approximation decimal. 

The control on the far right of the Section Edit panel is used for deleting sections in the active 

model. 

Once the section to be deleted has been selected, the system icon has been pressed and the 

corresponding confirmation request has been accepted, the system (if applicable) removes the 

section from the catalog and from the corresponding data grid. 

By means of a procedure similar to that of the materials catalogue, the program always 

guarantees the sequential and correlative order in the catalog of sections and, if necessary, 

after each elimination, automatically numbers the rest of the sections until the end of the 

catalogue. 

As an example, if at a certain moment there are 3 sections (S01, S02 and S04) and the user 

deletes section S02, the program now designates the old section S03 with the code S02. 

In order not to alter the associations of the real sections to the bars, the program 

automatically assigns section S02 to all the members that previously had section S03 assigned. 

These changes are logically reflected in the data grid on the screen. 

The system, therefore, controls the consistency of the assignments and the absence of gaps in 

the numbering of the sections. Additions always occur at the end of the catalogue. 

It also automatically verifies that there are no members associated with a section that you 

want to delete, and also checks that the section catalog of the model is never empty. 

[L].- Display options 

Below the parameter and data editing grids is the display options line. 

 

To the left of it are 14 icons grouped into 6 blocks. Its meaning is reflected on the next page for 

each of the blocks. 
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DATA GRIDS 

  
 

Data grids to the right of the graphics area 

 
Data grids not visible 

  

MEMBER THICKNESS CONFIGURATION 

  
 

Member thicknesses proportional to the section areas 

 
Uniform size member thicknesses 

  

MEMBER COLOR SETTINGS 

  
 

Member colors by section area ranges 

 
Member colors by sections (profiles) 

 
Member colors by materials 

 
No colors on the members 

  

CONFIGURATION OF THE TEXTS IN MEMBERS 

  
 

Values of the section areas in each member (in cm2) 

 
Name of sections (profiles) 

 
Materials name 

 
No texts on the members 

  

LEGEND SETTINGS 

  
 

Legend display indicator 

  

JOINTS DISPLAY 

  
 

Joints display indicator 

 

These display controls can also be assigned from the “View” submenu of the main menu, and 

the system synchronizes the status marks between the menu and the icons. 

Two numeric controls are shown on the right. They respectively indicate the values of the 

thickness of the members (if they are fixed) and the size of the joints. 
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[M].- Message and information line 

On the bottom line, the add-in provides various status messages in its left zone and the 

information related to the selected elements in its central zone. The right zone includes two 

icons for changing the language at any time. 

 

The Display mode is accessed through the icon   in the eighth position of the upper toolbar. 

In this mode, when the cursor passes through the vicinity of a joint or member, the system 

marks it in yellow and reports its characteristics on the bottom line: the numbering and 

coordinates in the case of joints and the numbering, profile, material, length and cross-

sectional area in the case of members. 

In the Parameter Edit mode, in addition to continuing the previous operation, when the 

parameter panel is activated, the system provides global information on the truss. 

This information includes the number of joints and members, total width and height, total 

length of its members, average length per member, total weight and average weight per 

member. 

In this way, the global impact produced by the variation of any parameter can be easily 

verified. 

[N].- Truss creation 

The program contemplates three series of basic types of truss: beam, column or lattice 

structures. 

To define a new truss, use the icons    located on the top toolbar of the graphic area. 

Each facilitates the generation of the corresponding type of structure. 

All have a high level of customization based on their corresponding parameters. Below are the 

initial designs of each type and a series of examples of their parametric design possibilities: 

BASE DESIGN OF THE “BEAM” TYPOLOGY
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PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE A

 
PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE B 

 
PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE C 
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BASE DESIGN OF THE “COLUMN” TYPOLOGY 

 

 

PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE D 
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PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE E 

 

 

PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE F 
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BASE DESIGN OF THE “LATTICE” TYPOLOGY 

 

PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE G 
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PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE H 

 

PARAMETRICALLY GENERATED STRUCTURE: EXAMPLE I 
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[O].- Truss storage and loading 

The REVIT Truss Designer add-in includes a convenient external storage system for truss 

models. 

All the definition data of each structure can be automatically incorporated into an individual 

file with the name that the user wishes and the extension “.tdp”. These files can be archived in 

any directory or device and the system has the capacity to read and write them directly, at any 

time. 

The size of the files is moderate (very few Kb) as the information is stored in text mode. Its 

internal organization is specific and the user does not need to know it in detail for its correct 

use. 

Access to the reading and writing functions of these TDP files occurs from the corresponding 

options in the "File" submenu (located on the far left of the application menu): 

 

By selecting the "Open..." option, the system displays the file search dialog and through it the 

user can access any device, drive or directory where the TDP file is stored. 

Once located, it is selected in the "Name" field and the "Open" button activates the process of 

reading its data and incorporating it into the add-in. The system directly replaces the current 

structure on the screen with the new model read from the file and automatically configures its 

corresponding parameter values. 

TDP files are readable and editable by any word processor, but it is recommended that they 

are always modified by the plugin (to avoid possible inconsistencies in externally modified data 

that could cause system malfunction). 

After loading a TDP file, the system displays a notice on the screen of the action taken. 

The “Close” option of the “File” submenu discards the current truss and proposes the creation 

of a new one of the “Beam” type. 

The storage of a structure and its archiving for later use is achieved with the options "Save" 

and "Save as ..." of the mentioned submenu. 
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The "Save" option directly updates the data of a previously generated TDP file. It is a useful 

option to keep the current state of the structure under analysis updated on disk or to define a 

structure in various time stages. 

To generate a new TDP file, use the "Save as..." option, which leads to the presentation of the 

file management dialog box. 

In it, the user can select the directory, unit or device where he wishes to store the new file and 

then indicate the chosen name in the "Name" editing field. 

By pressing the "Save" button, the system automatically concatenates the ".tdp" extension to 

the file name, extracts the data from the structure on the screen and generates the new file in 

the indicated location. 

The "Save as..." mode is particularly interesting for archiving the different states resulting from 

the analysis of a structure, and being able to return to a specific one of them at any time. 

After the process of storing the truss in a TDP file, the system presents a notice on the screen 

of the action carried out. 

Finally, the “Exit” option from the submenu closes the REVIT add-in. The system automatically 

creates an internal TDP file and allows it to be loaded when the add-in is reopened. In this way 

you can continue working with the same truss. 
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[P].- REVIT elements generation 

Through the first option of the "Process" submenu or the icon located in the ninth position of 

the toolbar, you access the configuration panel of the truss insertion process defined in the 

REVIT project. 

 

The REVIT project must already contain the appropriate FamilySymbols from the 

OST_StructuralFraming category. 

The upper box allows the assignment of each of the sections of the truss to its corresponding 

FamilySymbol. The system indicates the number of members detected in each section and 

provides a drop-down with the assignable FamilySymbol in each case. If the FamilySymbol is 

not assigned in any section, the system selects the first of the series. 

Next, in the lower drop-down menu, you must assign the REVIT level in which you want to 

insert the truss. 

The next line has three numeric edit fields for specifying the point REVIT insertion XYZ 

coordinates (0,0,0) of the truss. 

Although the truss is flat, it can be inserted rotated in space, with the angle in plan in relation 

to the X axis indicated on the bottom line. 

Finally, during insertion the add-in can optionally perform scaling with different factors on the 

horizontal and vertical axes. 
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The “Insert truss” button executes the element generation process in REVIT and exits the add-

in. When the add-in is reloaded the system allows to recover the previous truss and also all the 

configuration values. Therefore, the insertion process can be repeated as many times as 

desired (and with different parameters each time). 

A new insert does not remove the REVIT elements generated in the previous insert, but they 

can be easily deleted from REVIT (if desired). 

Below are several screens with the result of an example truss insertion test (in the Spanish 

version of REVIT). 
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[Q].- DXF graphic file generation 

By means of the penultimate icon  in the upper area, the add-in provides the possibility of 

automatically generating graphic files in standard DXF format for later use by AutoCAD© or 

other graphic editing programs. 

The system also carries out an automatic dimensioning and incorporates an organization in 

layers that allows a more controlled and versatile use of the graphic. 

The layers created by the system are listed below, with their name, their color code, the 

visibility indicator and the description of the elements it contains. 

 

Layer                Color  Visible    Elements 

  
0                      7       X       Default layer 

DIMENSIONS             6               Horizontal and vertical dimensions 

JOINTS                 4       X       Joint symbols 

MEMBERS                7       X       Member lines 

TXT_JOINTS             4               Joint numbers 

TXT_MEMBERS            7               Member numbers 

TXT_LENGTHS            1               Member lengths 

TXT_MATERIALS          6               Member code materials 

TXT_SECTIONS           6               Member code sections 

TXT_PROFILES           6               Member profiles 

TXT_AREAS              1               Section Areas 

 

The third column identifies the initially visible layers with an X. The user can change this 

assignment, as well as the color and name, in the graphical editor. 
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The build process can be executed at any time and with different model situations. By pressing 

the aforementioned icon, the system requests the location and name of the file, in each case. 

Once the process has been carried out, the program informs the user of the availability of the 

new file, through the appropriate message. 

Below is an example of the result of the generation of the DXF file corresponding to the sample 

model (with the English version of AutoCAD © 2022) 

 

[R].- Customization options 

REVIT Truss Designer has several customization possibilities in its image and operation. All of 

them are found in the “Options” submenu of the main menu. 

 



REVIT TRUSS DESIGNER                                                                                                                                                           USER GUIDE 

 
 

PAGE 31 
 

  

The first 6 allow the backgrounds of the different areas of the screen, the knots and the 

selected elements to have color. If these options are deactivated they are represented in 

different shades of gray. 

When they are activated, they are shown with default colors, but these can be customized in 

each case through the "Color assignment " option: 

 

When pressing "Assign color", the system presents the color selection panel (spanish versión) 
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The next two options allow confirmation requests and system information notifications to be 

shown (or not). 

Initially it is interesting that they are activated. When the user masters the system, they can be 

disabled if desired. 

The last option (“Dynamic element detection”) makes it possible for the system to mark and 

provide information on each element when the cursor passes through its vicinity (in the 

“Parameter edit” and “Display” modes). 

If this option is disabled, the items are marked and the system provides its detail information 

only when that item is clicked. 

[S].- Config files 

All system customizations (parameter operation, display modes, colors, and other options) can 

be stored in configuration files and retrieved at any time. 

The configuration files can be multiple and are managed through the "Config" submenu: 

 

Its operation is similar to that of managing TDP files, but in this case the files have a TDC 

extension and their format is logically very different. 

When the REVIT add-in is exited the system automatically creates an internal configuration file 

and allows it to be loaded when the add-in is reopened. In this way, all customization made is 

maintained. 

[T].- Change of language 

All REVIT Truss Designer texts can be presented in Spanish and English. To change the language 

at any time, you can use the "Language" submenu of the main menu: 
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You can also change the language with the icons in the lower right corner. The system 

synchronizes the indicator of the active language between the menu and the icons and 

maintains the previously selected language when the plugin is reopened. 

Below is an example of a screen in Spanish. The language change also affects all help windows, 

warnings, confirmations, notifications and information messages. 

 

[U].- Help system 

Las distintas posibilidades de ayuda del add-in REVIT Truss Designer se indican en el submenú  

“Ayuda” del menú principal: 

 

Its first option allows you to enable or disable popup help messages when the cursor passes 

over the icons or columns of the grids. At least until the system is mastered, it is convenient 

that they are enabled. 

The following option provides downloads of the PDF files with the user guides, in Spanish or 

English. 

Downloading the feature video in MP4 format is achieved by the third option. 
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Finally, the last option of the submenu presents the "About..." panel with the information 

corresponding to the Truss Designer add-in: 

 

[V].- App limitations 

The REVIT Truss Designer add-in is able to design planar truss structures with the following 

maximum sizes: 

 

LIMITATION VALUE  

 
Maximum number of joints 200 

Maximum number of members 1000 

Maximum number of materials 10 

Maximum number of sections 20 

Maximum length of the structure 100000 cm 

Maximum height of the structure 100000 cm 

 

 


